Palomar College — Graphic Communications

GCIP 141 Digital Imaging/Photoshop II
Six hours lecture/laboratory (3 units)

Instructor: Mark Bealo Email: mbealo@palomar.edu
Office: MD-146 Telephone: 760-744-1150 x 2958
Office Hours: M 2:30 -5:30PM, TTh 5-6PM

Catalog Description

The Concepts of intermediate digital imaging with Adobe Photoshop for visual, pictorial
and graphic use in all media. Effective image creation for motion graphics, publications
and internet for effective visual communications. CSU.

Student Learning Outcomes

At completion of course student will demonstrate an intermediate skill level of blending
modes, selective color, masking, transforming, duotone, curves and shapes.

Recommended Prerequisite
GCIP 140 Digital Imaging with Photoshop.

Requirement for the Following Certificates and/or Degrees
Digital Arts e Digital Imaging e Digital Publishing e Video Game Artist

Website

http://www2.palomar.edu/users/mbealo/

Follow the GCIP 141 link. The site contains the syllabus, a calendar detailing the
content covered each week and due dates, details on the usability project and grading
requirements. Supplemental material may be found as well.

Required Reading

Adobe Photoshop CS4 Studio Techniques, Ben Willmore. Adobe Press. ISBN:
0321613104

Recommended Reading

The Adobe® Photoshop® CC Book for Digital Photographers (2014 release), by Scott
Kelby. ISBN# 9780133900859.

Required Writing
Usability report (500-750 words). 1-2 page Web Site proposal (500 words).

Software
Photoshop CC, Illustrator CC, Dreamweaver CC, web browser.

Materials

The professor will provide instructions on how to gather and create images needed
to complete projects. Instructor will also provide information on obtaining additional
material that may be required.

Required Supplies

Thunderbolt, USB or thumb drives help out when it comes time to save. A big smile
and a healthy dose of enthusiasm goes a long way as well.



Open Lab Access
Open lab hours are subject to change - check lab schedules for updates.

Course Objectives

Successful students will be able to do the following by the end of the course:

1. Explain program management for allocations, preferences, and hardware
requirements.

2 Solve image problems with functions of the application.

3 Apply principles for using digital imaging as a design tool.

4 Demonstrate the use of the application as a production tool.

5. Demonstrate the creative capabilities of the application.

6. Demonstrate intermediate level of digital editing skills.

7 Apply the principles of color theories.

8 Demonstrate object oriented and digital files in collaboration.

9. Demonstrate the ability to create graphics for the web.

10. Demonstrate the use of digital imaging capturing devises.

11. Explain design concepts used in image development.

12. Demonstrate the concepts to develop steps in project planning.

13. Identify quality control needs for export files.

14. Demonstrate safe use of the equipment.

Outside Assignments

Students are expected to spend a minimum of three hours per unit per week in
class and on outside assignments. Students are to read text, study lecture/lab notes,
research and write required paper(s), and complete lab assignments.

Policies

1. Any student with a verified disability may be entitled to appropriate academic
accommodations. Please contact Disabled Student Services for more
information.

2. The GC Lab is available for your convenience in practicing and completing course

assighments. Lab hours are posted.

3. Your classroom participation counts as part of your final grade. Because this
course requires extensive hands-on application, attendance is imperative. If you
choose to drop this class, it is your responsibility to do so, not the responsibility
of the instructor. To drop the course use eServices otherwise, an F or FW will be
recorded on your permanent record.

4, Students should be aware of Palomar’s Student Rights and Responsibilities in the
2015-2016 Catalog. Please pay particular attention to the sections on Academic
Integrity, Drugs and Alcohol Policy, Smoking Policy, Sexual Harassment Policy,
Student Behavior Rules and Regulations, and the Student Conduct Code. [Also
Class Schedule]

5. Meeting deadlines is critical. All projects must be properly completed and
submitted by the assigned due date. If a project is turned in late, it is dropped a
minimum of one full letter grade per week.

Teaching Methods

Lectures and Hands-on Demos: Important material from the text and outside sources
will be covered in class. You are advised to take detailed notes on all lectures and
information in the readings. Participation in classroom discussions is a necessary
aspect of a healthy learning environment. Each student will be given the opportunity to
run the instructor station during a hands-on demonstration of a lesson. Each student
will present each project and details the steps used to get the final finished piece.



Students are also encouraged to bring in additional educational materials from outside
sources (Photoshop podcasts, tutorials, articles, etc) related to topics being discussed.

Assignments and Projects: Various projects and readings are assigned throughout
the course to solidify material learned in textbook lessons and lectures. Projects are
designed such that each student will have enough practice to become proficient in
understanding and correctly applying concepts and techniques learned through the
course. Various software applications might be used in creating the final files.

Online Materials: Additional items pertinent to the course and that enhance the
student's ability to learn the material may be posted. Refer to the class web site for
more information.

Evaluation

Evaluation for this course will consist of a series of projects, assignments, lessons and
class participation. Assignments are evaluated on demonstration of concept assigned,
use of media, handling of techniques, and completion by due date. These include but
are not limited to the following:

1. Self Portrait: Students are to successfully use layer masks or adjustment
layers, vector shapes or masks, saved alpha channels, and at least one clipping
group in creating a self portrait collage. Each student will also present and
explain their project to the class. This first assignment helps the instructor gage
the abilities of each student and their preparedness for intermediate Photoshop.

Grading - Personal Collage/Portrait (50 pts. possible)
Uses layer masks (>= 2) & adjustment layers (at least 2): 10 pts.
Includes vector shape(s) or mask(s): 10 pts.
Has at least one saved alpha channel: 10 pts.
Contains at least one clipping group: 10 pts.
Presentation: 10 pts.

2. 8x10 Digital Painting: 360 ppi image size: The project is designed to display
student's understanding and competency with various brush tools and options
in combination with other tools and functions covered in the first 3 chapters.
Please pay particular attention to the section on brushes in Chapter 1 which
describe in detail the brush tools and options. Use that knowledge to create an
image that is similar in intricacy to the examples shown in class. Projects that do
not adhere to these directions will receive a reflective grade, those that follow
the requirements will be rewarded for their attention to detail. [Uses scatter
brushes with options other than default. Uses various brushes to give the image
depth and shading.] Each student will use various brushes, their attributes and
dynamics in order to simulate a painted piece of artwork. A photograph or other
suitable image may be used as a template from which to create the "painted"
image.

Grading - Digital Painting (100 pts. possible)
Uses various Opacity and Flow settings (Fig. 1.59-1.60): 7 pts.
Used a selected area to Define Brush (Select the area: Edit > Define Brush
Preset): 8 pts.

Brush Tip Shape

Uses different Roundness settings (Fig. 1.38, 1.39): 7 pts.
Uses different Angle settings (Fig. 1.40): 7 pts.

Uses various Spacing settings (Fig. 1.41, 1.42): 7 pts.
Uses Jitter (Fig. 1.43, 1.44, 1.46-1.48, 1.52): 8 pts.

Uses Fade (Fig. 1.45): 8 pts.



Vary settings with Scatter (Fig. 1.49-1.50): 8 pts.
Uses Texture settings (Fig. 1.51-1.52): 8 pts.
Uses at least one Dual Brush (Fig. 1.53): 7 pts.
Varies the Color Dynamics (Fig. 1.54-1.58): 8 pts.
Uses the Wet Edges setting (Fig. 1.62): 7 pts.
Correct Dimensions and PPI: 10 pts.

Line Art/Grayscale: Scan or convert 3 different line art images such that

you end up with 3 files that fit the following output parameters: one for a 600
dpi Laser Printer, one for a 720 dpi InkJet, and one based on a student choice
device. Keep the background layer as the original scan or image, and create a
duplicate layer or layers that are labeled with descriptions of the corrections you
make on each. Save the files as PSD format and turn it into the instructor with
your name and version (ex. BealoM_LineArtl.psd).

Repeat the above layout with 3 different grayscale images (black and white
photos) or color photos that have been converted to black and white (grayscale)
based on the following parameters: one about 4x5" for newsprint at 85 Ipi, one
8x10 for the web, and the last one based on student choice output. Detail the
settings that you used to achieve the optimum results on each layer and include
all layers and adjustments (do not flatten). For the student choice, be sure to
describe the intended mode of output (ex. printed brochure at 150 Ipi, web
page, etc.) Save the 3 files as PSD format and turn it into the instructor with
your name and version (ex. BealoM_Grayscale3.psd).

Grading - Line Art/Grayscale: (100 pts. possible)
LineArt:

Details 20 pts.

3 Images 30 pts.

Improved image still has shades of gray -15 pts.

Grayscale:
Details 20 pts.
3 images 30 pts.
Simplistic corrections (As in you didn't use curves or levels or other more
advanced functions. If brightness/contrast is your main adjustment, it is
time to learn more effective tools.) -15 pts.

Color Correction Project: Perform color correction using the various
intermediate techniques taught during the course on a series of images

Perform color correction on 4 photographs that are in need of a decent amount
of correcting. You may need to scan these or you may already have some from
a digital camera or some other source. Each photo the correct resolution (Bonus
Ch. 5 on the CD) and size for the desired output devise: 10 pts possible. Use
various adjustment layers (Ch. 10) and layer sets (p. 129-130) to make it easier
to compare the results of each and switch between the options.

You may end up with several variations of each photo. Each needs to use at
least one of the techniques from chapters 5, 7, and 9 so that you can show that
you have experience with all of them by the end of the assignment.

Grading - Color Correction: (100 pts. possible)
Each of the 4 photos must use at least one of the following, such that by
the time you finish the assignment, you have used all of them. In addition,
you should be using Adjustment Layers for a majority of the adjustments:



Levels (Ch. 7): 7 pts.

Curves (p. 115-143, 290-294) RGB Master adjustment and individual R, G,
and B adjustments: 10 pts.

Shadow Highlight (p. 144-148): 5 pts.

Proper RGB Workspace and/or Convert to Profile (especially if it will be in
CMYK for the final output.)[CS3 p. 215-221]: 5 pts.

Hue/Saturation using Master adjustment and other individual colors (p.
274-287): 10 pts.

Color Balance (p. 289-290): 7 pts.

Selective Color (p. 294-296): 7 pts.

Match Color (p. 296-298): 7 pts.

Color Replacement Tool (p. 299-301): 7 pts.

You may wish to change opacity on Adjustment Layers to limit the effect.
Photo Filter (p. 192-194): 5 pts.

Blending Modes to limit the effect to certain areas, colors etc. - Hue, Color,
Luminosity (p. 195-196): 10 pts.

Empty Adjustment Layer (if needed - p. 197)

Blending Sliders- Limiting Brightness that is effected (p. 202-203): 5 pts.
Layer Masks - Limiting Layers that are effected (p. 203-206): 5 pts.

5. Video & 3D

6. Thematic Posters: Using techniques and tools described in the Chapters on
Sharpening (Ch. 6), Enhancement, Advanced Masking (Ch. 9), Collage (Ch.
10), and the pdf on Shadows, create 2 posters for one event of your choice.
The Superbowl in San Diego, The Wild Animal Park, The Zoo, Street Scene, A
Local Art Show/Exhibit, Surf Competition, Marathon, Festival of Animation, Fleet
Week, Street Fairs, and the like would all be good targets.

Make the posters 17 x 22 at 200 ppi.

Grading - Thematic Posters: (100 pts. possible)
Correct Dimensions: 3 ea.
Uses Shadows 3 ea. [refer to the last half of the video on shadows from the
web site]
At least one has a Clipping Mask: 6 pts.
At least one has a Layer Mask: 6 pts.
At least one has a Vector Mask: 6 pts.
Uses all of the following Blending Modes @ 3 ea. (51 pts. total):
Darken, Multiply, Color Burn, Linear Burn, Lighten, Screen, Color
Dodge, Overlay, Soft Light, Hard Light, Vivid Light, Linear Light, Pin Light,
Hue, Saturation, Color, and Luminance.

At least one has a posterized image using techniques discussed in class: 7
pts.

At least one has a texture that was created using techniques discussed in
class: 6 pts.

At least one has an image that was liquified: 6 pts.

7. Usability Report: The purpose of performing usability testing is to find out as
much as you can about people’s perceptions of the navigation and details of a
web site, before one gets too far into the process and finds out that visitors just
don’t understand the site.

Start off by reviewing the Web Site Project link to get an idea of what your
Interface Design will be targeted toward. Follow that up with the Prototype



Usability Report guidelines link on the class web site in order to sketch out an
Interface Design idea and test it.

Grading - Usability Report: (200 pts. possible)
Proper length: 100 pts.
Grammar, well written, clear and easy to understand: 100 pts.

Web Interface Design: Using information gained from the Usability Report,
the student will design a 4-6 page web site using Photoshop and Dreamweaver.
The site will showcase the web development technologies and techniques
learned in class.

Incorporate techniques from pdf lessons 14, 15, and 16, along with the
information gleaned from the Usability report. Instructor will include extra
information for those who need a refresher on Optimizing Images, Image Maps,
Slices, Rollovers and Animation. You may refer to these links for online tutorials:
http://www.graphicsfocus.com/ps/tutorial/animation-interactive.htm http://
www.redneckshouse.com/Photoshop.html

Also have a look at the following examples of former students' projects:
http://www2.palomar.edu/users/mbealo/gcipl41/examplel/index.html
http://www2.palomar.edu/users/mbealo/gcipl41/example2/index.htm

http://www2.palomar.edu/users/mbealo/gcipl41/example3/index.html

The first page will be the index.html (home page) file [ex. http://www.adobe.
com]. The site also needs to have a second level (linked directly from index
page), [ex. http://www.adobe.com/products/] and third level (link from the
second level - although may also be linked from index page, just not part of the
main navigation) [ex. http://www.adobe.com/products/Photoshop/main.html].
Pick your choice of levels (2nd, 3rd, 4th, etc.) for the other pages.

The interface design must:

correlate with the Usability report, use slices and rollovers (L-15), include a gif
animation (L-16) relevant to the site design, not some random animation with
no purpose, and include optimized graphics (ch. 14).

The gif animation should use at least 6 layers and be at least 10 frames long. It
also needs to have motion and transparency changes. Make sure it is not larger
than 80k when optimized. In addition to the animation that is on the site, you
need to turn the original PSD file with all of its layers in as well. That will be the
copy graded for the animation assignment.

Grading - Web Site: (100 pts. possible)
Tied to Usability Report: 8 pts.
<= 1024x768 pixels: 8 pts.
72 ppi Images: 8 pts.
Proper Image Format: 8 pts. Uses Layer Styles: 8 pts.

Slices

Use Text 8 pts.

Have Links 8 pts.

Use Message Text 8 pts. Use Alt Tags 8 pts. Proper File Names 8 pts.
Has Primary Rollovers 20 pts.

Web Animation - Within the 3 versions, you must demonstrate the ability to
correctly use position, opacity, and effects tweening. Within means that not
every animation has to use all 3 types of tweens, just what is appropriate for
that animation (at least one type each).



Each must contain at least 6 layers and 6 frames.
Maximum size of animated gif is to be NO LARGER THAN 80K.

Turn in: Original PSD file so that I can see all of your layers, tweens, and effects,
and the final optimized animated gif with the usual naming conventions.

Grading - Web Animation (100 pts. possible)
3 versions of gif animations: Rectangle, Leaderboard, ~300 x 250. 1) File
-> New, Preset: Web, Size: Rectangle, 180x50
2) File -> New, Preset: Web, Size: Leaderboard, 728x90
3) Student choice, but no larger than 300 x 250.
Correct Size = 5 pts. ea.
6+ Layers = 5 pts. ea.
6+ Frames = 5 pts. ea.
Each File < 80k = 5 pts. ea.
Position Tween = 15 pts
Opacity Tween = 15 pts
F/X Tween = 10 pts

9. Student Choice Project: Each student will submit a proposal to be cleared
by the instructor for their final project. Only projects that describe the use of a
substantial amount of tools and techniques learned throughout the semester will
be given the ok to proceed.

The skills learned from the course text must be used in the production of the
final project. It may be designed for either print, web, or electronic delivery.
Each student has a different focus, and I don't wish to quench that by being too
constricting. However, you must include in your proposal a description of which
chapters from our text directly apply to the creation of your final project. Grade
details will be discussed with each student based on the individual projects. (100
pts. possible)

Projects and assignments will account for approximately 75% of your final grade,
whereas classroom participation will account for 8%, and written reports about 17%.
Each project will reflect specific editing techniques and may have special output
properties. Details will be given defining the parameters of each project. The grading
scale for the course is as follows:

90-100% = A 80-90% =B 70-80% = C 60-70% =D <60% =F

Important Dates

All outstanding fees must be paid within 10 days of registration to avoid being dropped
from classes. If you need $$ for college, apply for a BOGW fee waiver. If students are
not sure about their fee balances, they can check them through eServices at www.
palomar.edu.

Last day to qualify for a refund for Sping Semester classes Sunday, January 31
Last day to add or register for Sping classes Sunday, January 31
Last day to drop with no notation on record Sunday, January 31
Last day to apply for May 2016 graduation Friday, February 28
Last day to drop with a *“W"” on record Saturday, March 14

Final Project Due See Final Exam Schedule in Class Schedule or Check Class Calendar



Excerpts from Palomar’s Educational Philosophy

from the 2000-2001 Catalog, p. 13

The educational philosophy of Palomar College is based upon belief in the value of the
individual and belief in the individual's potential for intellectual, ethical, personal, and
social growth. Only through growth in these areas can a citizen come to understand
personal rights...

Excerpt From Teaching to Learning — A New Paradigm for Undergraduate
Education

By Robert B. Barr and John Tagg

In the Learning Paradigm... a college's purpose is not to transfer knowledge but to
create environments and experiences that bring students to discover and construct
knowledge for themselves, to make students members of communities of learners that
make discoveries and solve problems. The college aims, in fact, to create a series of
ever more powerful learning environments...

Selected Excerpts from Student Code of Conduct

II. Standards of conduct. Here is a list of examples of conduct inappropriate and
unacceptable for which students should expect to be held accountable.
A. Students are expected to avoid any type of dishonesty, including, but not
limited to cheating, plagiarism, forgery, fabrication or counterfeiting documents,
furnishing false information to the College, alteration or misuse of college
documents or records, duplication of assignments, or aiding another in an act
of dishonesty. As noted in the Statement of Academic Integrity, honesty is of
utmost importance in all endeavors related to the College. A detailed discussion of
academic dishonesty and related consequences are addressed in Section II.
I. Continued disruptive behavior, profanity or vulgarity, or defiance of the authority
of, or abuse of College personnel.
L. Misuse of District computers, telephone, or telecommunications devices.

Also refer to : http://www.palomar.edu/studentactivities/statement _on_academic
integrity.htm

Final Note

The instructor reserves the right to make any needed and appropriate adjustments to
this syllabus.




